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1. INTRODUCTION TO MINNOW 2.0

The Minnow 2.0 logger is a high accuracy, water
resistant, compact, temperature and humidity data
logger. The logger features a compact LCD display. The
logger comes with a free Windows and MAC application.

This user guide provides basic information about how to
use the logger and Windows/MAC applications. Both the
logger and the applications have been designed to be
intuitive so that you will be up and running with the
logger in a matter of minutes.

The Minnow 2.0 comes in two versions; Minnow 2.0T is
a temperature only version and Minnow 2.0TH is a
temperature and humidity logger. This user guide
applies for both versions.
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Figure 1: Senonics Minnow 2.0
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2. TECHNICAL SPECIFICATION

For a technical specification of Minnow 2.0 please consult the product overview.

http://senonics.com/files/Minnow2ProductOverview.pdf
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3.  USING MINNOW 2.0

Minnow 2.0 logger includes two buttons:

START button:

When configured for "Button Press" logger start, this

button starts and stops logging. In other
configurations, this button is inactive.
DISPLAY button:

This button allows the user to cycle through all LCD
views.

Status LED Alarm LED

\\"G" P
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|
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START DISPLAY
SENONICS /|

Figure 2: Buttons, LEDs and LCD

Minnow 2.0 includes two LEDs:

|
status LED: O

When the logger starts logging then this LED pulses
green once for 1 second.

When logging this LED flashes green for 7
milliseconds and off for 6 seconds.

When the logger stops then this LED pulses red for
1 second then off.

If the logger becomes full this LED flashes red for 7
milliseconds and off for 6 seconds.
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Alarm LED: ®

When a temperature and/or humidity alarm is
triggered this LED flashes red for 7 milliseconds and
off for 6 seconds.

A number of display screens can be stepped through by
pressing the "display" button.

The current screen shows current temperature and
humidity.

= 35.0%
2H.3c-

CUR

A further screen shows the maximum readings during a
logging period.

- 392+
£3.c09e

The third screen shows the minimum readings during a

logging period.
m 10.9%

19.4b.

There is also a screen to show the average temperature
and humidity during logging (from last configuration).
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A screen shows upper alarm settings.

OO0
000
L

ALMH

A further screen shows the lower alarm settings.

om  10.0%

. H]'DD

When the logger is logging the star-like logging
indicator * is displayed.

e J5.94
ST T
cH.ac

CUR

When alarms has been triggered, the alarm
indication © is displayed.

359+
2H.4c-

CUR
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4. PC APPLICATION

Your logger may be controlled from a Windows PC or Mac
from USB using a simple application.

4.1. Senonics GUI Main Screen

The Senonics GUI includes a configuration pane, a
graphical pane and a spreadsheet pane. Included also is
a connection indication to signify connection or
otherwise of a Senonics logger.

To install for Windows download:
http://senonics.com/bin/SenonicsPCApplication Installer.zip

To install for Mac navigate to:
http://senonics.com/mac-installer.html

¥ Senonics PC Application (1.2.3) = ] X
File View Export Options Language Text Help
Connection E}
Indication
Temperature " - A
Logger Minnow 2.0TH (Temperature & Humidity) Humidtty DatsTIe T Homidity i
S Rorad Dow Pont 20180210 103142 2274C  3066%  457C
20180210 103212 2271C  3067%  456C
ECTme 2018.03:16:21:45:16 20180210 103242 271C  3086%  455C
Logger Tme | 2018.03.16 21:46:29 20180210 103312 2274C  3072%  460C
Logging Start 20180210 103342 2274C  3071%  460C
e = 20180210 103412 2274C  3079%  463C
o =
) S0 (s 20180210 103442 2272C | 0R2%  459C
Lo 20180210 103512 2272C  302%  459C
20180210 103542 2272C  3073%  460C
jlepaiure 20180210 103612 2274C  3082%  465C
Alarm Threshold (High) | disabled - 20180210 103642  2274C  3088%  467C
Alarm Threshold (Low) 2018.02.10 10:37:12 22.74C 30.82 % 465C
20180210 103742 2275C  3079%  465C
Humidity 20180210 103812 2274C  3092%  470C
e~ 20180210 103842 2275C  3082%  466C
Alarm Threshold (High) d_bﬂed- 20180210 10312  2275C  3088%  4.69C
Alarm Threshold (Low) | disabled i 20180210 10:39:42  2278C  3097%  476C
20180210 104012 2276C  3093%  472C
S 20180210 104042 275C  3091% | A70C
Fmware Revision 0180210 104112 2276C  3084%  468C
e = = 20180210 1041:42  2275C  3084%  472C
— 20180210 104212 2278C  3087%  4TIC
T R TR
oo Spreadsheet Pane ;¢
Info: 20180210 104342 2278C  3093%  4TC
D;r?':z 'é:;(tto zo0m l;ut 2018.02.10 10:44:12  22.79C 3093 % 475¢C
£ S 20180210 104442 2275C  3086%  A468C
20180210 104512 2278C  3091%  47C
20180210 104542 2279C  3091%  474C
- + 20180210 104612 2281C  3093%  476C
Configuration Pane 20180210 104642 2281C  3093%  476C
20180210 104712 2281C  309%  479C
20180210 104742 2282C  3095%  478C
20180210 104812 2279C  3088%  4TC
20180210 104842 2279C  3088% = 47C
Configure Logger Read Data 20180210 104912 2279C  3085%  4TIC
20180210 104942 2282C  3087%  475C
‘ Configwe Rond 20180210 105012 2282C  3081%  472C
e — g . 20180210 105042 2282C  3084%  4TC
2018.02.02018.02.02018.02.02018.02.1 18.02.02018.02.02018.02.08018.02.082018.02.02018.02.09
[ 0% 16:31:12 06:21:12 20:11:42 10:01:42 23:52:12 13:42:42 03:32:42 17:23:12 07:13:12 21:03:42 20180210 105112 | 2282C | 30.72% | 467C v
. >
Figure 3: Senonics GUI
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4.2. Configuring a Logger

Configuration of the logger is performed with the logger Wait for the logger to finish configuration (indicated by
connected. the busy indication disappearing).

Update all settings on the configuration pane such as _
logger name, logger start option (on disconnection, A Logger BUS_V
button press or at specified time), logging interval (1

second, 10 seconds, 30 seconds, 1 minute, 10 minutes,

30 minutes or 1 hour), temperature and humidity logging
enables, temperature and humidity alarm levels.

When complete press the configure button.

X Configure

¥ Senanics PC Application (12.3) — m] X

File View Export Options Language Tedt Help

s Logger 5usy IS
Temperature DateTime Temp Humidity DewPt

Logger Minnow 2.0TH (Temperature & Hurnidity) Humidity
Dew Point % 16562  2018.02.10 10:31:42 2274C 30.66 % 457C

16563  2018.02.10 10:32:12 271C 3067 % 456 C
16564 2018.0210 10:3242  2271C 30.66 % 435C
16565 2018.02.10 10:33:12 2274C 30.72% 460 C
16566 2018.02.10 10:33:42  2274C 30.71% 460 C
16567  2018.02.10 10:34:12 2274C 30.79 % 463 C
16568 2018.02.10 10:34:42 2720 3072% 439C

Device ID Room#24
PC Time
Logger Time 2018.03.16 21:47:05

Logging Start Button Press

Logaing Interval | 30 secs (max 22 da ~

Lo 16569 20180210 10:3512  2272C | 3072%  459C
Temperst 16570 20180210 10:3542  2272C | 3073%  460C
Emperstire 16571 20120210 10:36:12  2274C  3082%  465C
Alarm Threshold (High) 16572 20180210 10:36:42  2274C  3088%  467C
Al Threshold (Low) 16573 20120210 10:37:12  2274C | 3082%  465C
16574 20180210 10:3742  2275C | 3079%  465C
Hurmidity ; 16575 20120210 10:3812  2274C  3092%  470C
. 16576 20180210 10:3842  2275C | 3082%  466C

Alarm Threshold (High) ] Configuration X
16577 20180210 10:3912  2275C | 3088%  49C
Algrm Threshold (Low) This will erase all data on device. 16578 20120210 10:39:42  2273C  3087%  4T6C
-, Are you sure you want to configure? 16579 20180210 10:40:12  2276C  3083%  472C

us

16580 2018.02.10 10:40:42  2273C 3091% 470C

Firmware Revision 20020 III 0 16581 2018.02.10 10:41:12 2276 C 3084 % 468 C

Battery Level | BE 16502 20120210 10:41:42  2275C  084%  472C
16583  2018.02.10 10:42:12 27mcC 30.87 % 4nc

16584 2018.02.10 10:42:42 278C 3091 % 473C
16585 2018.02.10 10:43:12 2278C 30.87 % 471C
16586 2018.02.10 10:43:42 2278C 3093 % 473C
16587 2018.0210 1044712  2273C 3093 % 475¢C
16588 2018.02.10 10:44:42 2275C 30.86 % 468 C
16589 2018.02.10 104512  2278C 3091 % 473C
16590 2018.02.10 10:45:42 2279C 3091 % 474C
16591 2018.02.10 10:46:12 281C 3093 % 476 C
16592 2018.02.10 10:46:42 2281C 3093 % 476 C
16593 2018.02.10 10:47:12 2281C 3099 % 479C
16594 2018.02.10 104742  2282C 3095 % 473 C
16595  2018.02.10 10:48:12 2279C 30.88 % 473C
16596 2018.02.10 104842  2273C 30.88 % 473C
16597  2018.02.10 10:4%:12 2279C 3085 % 4nc
16598 2018.02.10 10:43:42 2282C 3087 % 473C
16599  2018.02.10 10:50:12 228C 3081 % 472¢C
16600 2018.02.10 10:50:42 2282C 3084 % 473C
16601 2018.0210 10:51:12 2282C 3072 % 467C

u
=

Info:
Draw box to zoom in
Right click to zoom out

K e [

I 0%

Figure 4: Configuration
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4.3. Retrieving Logger Data

Data can be retrieved from the logger by connecting to
the logger and then pressing the read button at the
bottom left of the GUI. Both the device configuration and
logged data will become uploaded and viewable in the
configuration, graphical and spreadsheet views.

¥ sencnics PC Application (1.2.3)
File View Eport Options Langusge Ted Help

Logging Interval 30 secs (max 22 da ¥

Logger Minnow 2.0TH (Temperature & Humidity)
Device ID Room#24
PC Time 2018.03.16 21:45:16
Logger Time 2018.03.16 21:46:29
Logaing Start
Temperature
Alarm Threshold (High)
Alarm Threshold (Low)
Humidity
Alarm Threshold (High)
Alarm Threshold (Low)
Status

Firmware Revision 20020
.

w
=

Battery Level

Info:
Draw box to zoom in
Right click to zoom out

T
ENEI

4.4.

Temperature DateTime Temp Humidity ~ DewPt #

Humidity

Dew Point 20180210 103142 2274C  30.66% 457C
20180210 103212 271C 067 % 456C
20120210 10:3242  2271C  30.66% 455¢C
20120210 10:33:12  2274C  072% 460 C
20180210 10:33:42  2274C 071 % 460 C
20180210 10:3412 | 2274C  30.79% 483C
20180210 103442 272C 0% 459C
20180210 103512 272C  0R% 459C
20180210 103542 272C  0B% 460 C
20180210 103612 2274C  30.82% 465C
20180210 10:36:42  2274C  30.88% 467C
20120210 103712 2274C  30.82% 465C
20120210 103742 2275C  30.79% 465C
20180210 10:38:12  2274C  30.92% 470C
20180210 10:3842  2275C  30.82% 466 C
20180210 103912 275C  30.88% 469 C
20180210 10:39:42  278C 3097 % 476C
20180210 104012 2276C 3093 % 472C
20180210 104042 275C  3091% 470C
20180210 104112 2276C  30.84% 468C
20180210 104142 2275C  30.94% a72C
20120210 10:4212  2278C  30.87% amc
20120210 10:4242  2278C  30.91% 4713C
20180210 104312 2278C  30.87% a7c
20180210 10:43:42  2278C 30983 % 473C
20180210 104412 278C 3093 % 475¢C
20180210 104442 2275C  30.86% 468C
20180210 104512 278C  3091% 473C
20120210 104542 278C  30.91% 474C
20180210 104612 2281C 3093 % 476C
20120210 10:46:42  2281C  3093% 476C
20120210 104712 2281C  30.99% 479C
20180210 104742 2282C  30.95% 478C
20180210 10:48:12  2279C  30.88% 473C
20180210 104842 2278C  30.88% 473C
20180210 10:49:12  2278C  30.85% anc
20180210 104942 2282C  30.87% 475¢C
20180210 10:50:12 | 2282C  30.81% a7nC
20180210 10:50:42 | 2282C  30.84% 473C
20120210 10:51:12 | 2282C  0T2% 46TC v

>

Figure 5: Retrieving Logger Data

Saving and Opening CSV

Logger data and configuration may be exported to file in
Comma Separated Value (CSV) format. This format can
be edited by third party software such as Microsoft Excel
or read back into the Logger PC application at a later
point.

Revision 1.0.5
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To write a CSV file navigate File>Save CSV.

To read a CSV file back select File>Open CSV, and
then navigate to the CSV file.
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4.5. Cloning Loggers

For customers that expect to configure multiple loggers
with the same configuration, Senonics offer the clone

feature.

5|

First, press the clone icon
File>Clone Logger.

or navigate
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Minnow 2.0T & Minnow 2.0TH

User Guide

sales@senonics.com

time with the same cloned settings.

You can then connect loggers to your PC. When you
press "Configure” the new logger is programmed each

Be aware that the Device ID is not cloned, in order to

unlock, change settings and then lock again.

You are then presented with two copies of the
configuration pane. Enter your configuration in the left-
most pane. When you are complete press the "Clone
Settings" button. This will copy all settings across to the
right-most pane. When you are satisfied press the "Lock

Settings" tick-box.

¥ senonics PC Application (1.2.3)
File View Export Options Language Text Help

Gk
Minnow 2.0TH (Temperature & Humidity}

Room#24
2018.03.16 21:46:20
2018.02.16 21:47:33

Button Press -

Logger
Device ID

PC Time
Logager Time
Logging Start
Logging Interval | 30 secs (max 22 da =

LCD On i

Temperature
‘Alarm Threshold (High) | disabled A
Alarm Threshold (Low) | disabled -

Humidity
Alarm Threshold (High) | disabled -
Alarm Threshold (Low) | disabled v

Status

Firmware Revision
Battery Level - 50%
Revision 1.0.5
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Room#24

Device ID

Logging Start Button Press -

Logging Interval | 30 secs (max 22 da ~

LCD On ke

Temperature
Alarm Threshold (High) disabled -
Alarm Threshold (Low) | disabled -

Humidity
Alarm Threshold (High) disabled -
Alarm Threshold (Low) disabled -

[ Lock Settings

Clone Settings

Configure

0%

Figure 6: Logger Cloning

Senonics LLC ©
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preserve the logger identification. At any time, you can
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4.6. Auto Read to File

Some customers like the ability to be able to connect a ¥ Read and save Options %
logger and automatically download and save data to file.

@ Mone
Select Options>Read and Save Options. ) Auto read on connection

() Auto read and save on connection

You are then presented with three options:
a) to disable auto-reading of the logger (default)

Log Folder | C: [Desktop | I

. . Indude Field:

b) to automatically read the logger data on connection nese fEes | Legger D Up
to the Senonics GUI Date
o the Senonics — —

c) to automatically read the logger data on connection

. Fu #24_20180316_214712.
to the GUI and save to file oo - =

Figure 7: Read and Save Options

In saving to file you can change the order of the date,
time and logger ID as they appear in the file name.

4.7. Opening Excel 4.8. PDF Reports

PDF

. | A

It is possible to press the Excel button or navigate Open a one-page PDF report by pressing the PDF
Export>Open Excel to show the data in Microsoft icon or navigating Export>Save PDF. A PDF is written
Excel. During this process the user needs to select if to summarize the data in the logger by way of statistics
your version of Excel is expecting and "." or "," to and as a graph. The PDF can be written either in US
represent the number decimal point. Letter page size of A4 page size.
This capability assumes that Microsoft excel is installed The user can enter one’s own notes at the footer of the
on your PC. If not, then the option will not work. This PDF. PDFs are written to file and can be opened by any
option is not available on the Mac version of the GUI. standard PDF reader — like Adobe Acrobat.

= Senonics Data Logger Repor

Setup
Loggor Sanorics Minnaw 2 0TH - Roome24
Loggor Stat Sutton s
Leoger Inenval Wsecs

Alams
Temparatura Loggng Enatled Humicty Logging Enatied
Temperature Alam (Highi.  nan Humiaty Alarm (High).  nan
Temparature Alam (Highl.  nan Huricly Alarm (High),  nan

Statistics

Hur
Hu

mioy Madmum: 43,66 %

‘‘‘‘‘ ity Minimom: 2175 %
ity Aversy 038%

16808

» 5 Temperahre Huricty Dew Paint 50

h | | i

: w 4 \f N !‘-‘\\J, ‘.\,« F“v\_‘r § )

pmim [ e ' - Y " fh_ai“f\,.‘ J RN "\‘ ‘\‘“F ;}\‘,\ )
T TN Y

{ al + J IV A )/ !

Figure 8: Opening Excel ’ N,

Ec
S
2|
5
8

Figure 9: Writing PDF Reports
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49. External Sensors

Minnow 2.0 is capable of working with an external sensor. I Senonics PC Application (1.2.3)
1. Plug your Minnow 2.0 into the PC with the PC application running. The File View Bgport Options Lenguage Tet Help
extension cable will be disconnected. = QE mtemal  Show internal sansc
. ) . E= xternal datz
2. Select all desired configuration. L
3. Select the type of extension cable you have. Logger Minnow 2.0TH (Temperature & Humidity)
4. Configure Devce 10
S ' PC Time
5. Disconnect the logger [——
6. Connect the extension cable. Logging Start | Button Press -
Logaing Interval | 30 secs (max 22 da ~
The logger will be showing internal (CUR) and external (EXT) readings as one Lco on -
cycles through the display screens. _
Extension Cable
Cable Type External T/H Cable 12 ~
MHone
e 11

External T Cabl

) 35.9 % Temperature
Alarm Threshold (High) | disabled -

l } “ °c Alarm Threshold (Low) | disabled -
.
CUR

Humidity (Ext Sensor)

Alarm Threshold (High) | disabled hd
Alrm Threshold (Low) | disabled -
. o
HEE ] Status
EIH E 9 Fimware Revision ]
- C Battery Level 0%
EXT

Info:
Draw box to zoom in
Right click to zoom out

(2
.? Configure . ‘t Read

0%

Figure 10: External Sensor Configuration
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When you are ready to download the data:
1. Disconnect the external sensor
2. Connect the logger to the PC
3. Read the logger. Both internal and external data is downloaded.
[ Senonics PC Application (1.2.3) - m] x
File View Bxport Options Language Tet Help
Show internal sensor or £
[ Ext Sensor Jfextemal sensor data it 7]
Logger Minnow 2.0TH ( Temperature & Humidity) ;i:&ﬁt?:‘é)m) o DtETImE Tempint | Humint | DewPtint | TempEd | HumEBd | Dewbtba &
16568 20780210 103442 22420 30.72% 4590 23030 3047 % a8ic
Eeiceling TEnt () 16569 20180210 10:3512  2272C  3072%  459C  2311C  3045%  481C
PC Time 16570 20180210 10:3542  2272C | 3073%  460C  2313C | 3035%  ATIC
Logger Time 16571 20120210 103612 2274C  3082%  485C  23.06C | 3046%  484C
6572 20120210 103642 2274C  3088%  467C  2316C | 3038%  481C
I TDEET 6573 20180210 103712 27AC  082%  465C  2313C  0A1%  480C
Logging Interval 16574 20180210 103742 | 2275C | 3079%  465C  2313C | 3039% | 479C
) 16575 20120210 103812 2274C  3092% | 470C  2315C | 3040%  481C
16576 20120210 103842 2275C  3082%  466C  2301C | 3038%  4T6C
Extension Cable 16577 20180210 103912 2275C  3088%  469C  2315C | 3047%  484C
Cable Type 16578 20180210 10:3%:42  2278C  3097%  4T6C 2315C | 3042%  482C
16579 20180210 104012 2276C  3093% | 472C  2396C | 3043%  483C
Temperature (Ext Sensor) 16580 20180210 104042 2275C  3091% | 470C  2316C | 3047%  485C
16581 20180210 104112 2276C  3084%  468C  2315C | 3042%  482C
Alarm Threshold (High) 16582 20180210 104142 2275C  3084%  472C  2I5C | 04T%  484C
Alarm Threshold (Low) 16583 20180210 104212 2278C  3087%  ATIC 2316C | 3037%  480C
16584 20120210 104242 2278C  3091%  473C  2396C | 0M%  48C
(s (& Sever) 16585 20180210 104312 2278C | 3087%  4TIC | 237C | 043%  4mC
Alarm Threshold (High) 16586 20120210 104342 2278C  3093% | 4T3C  2307C | 041%  48C
> 6587 20120210 104412 2279C  3093%  475C 23200 041%  486C
rm e ) 658 20180210 104442 2275C  086%  468C  2318C  0T%  4BC
r— 16589 20120210 104512 2278C  3081%  473C  2348C  3034%  481C
16500 20120210 104542 2279C  3091% | 4TAC  2308C | 3038%  483C
FmTEe M T L ] 16591 20180210 10:46:12  2281C  3093%  476C  2316C  3041%  482C
Battery Level e 16592 20180210 104642 2281C  3093%  476C  2316C | 3043%  483C
16503 20180210 104712 2281C  3098%  479C  2307C | 3055%  480C
16504 20120210 104742 2282C  3095%  478C  2303C | 3038%  483C
16505 20180210 1048712 2279C  3088%  473C  2398C | 3038%  483C
Tnfo: 16505 20180210 104842  2279C  3088%  473C  2320C  3031%  481C
3,';;: e L 16597 20180210 104912 2279C  3085% | 471C  2320C | 3031%  481C
16598 20120210 104942  2282C  3087% | 475C  2320C | 3038%  475C
16599 20120210 105012 2282C  3081% | 472C  2397C | 035%  4T6C
660D 20120210 105042 2282C  3084% | 4T3C  2320C | 3043%  4T3C
16601 20120210 105112 2282C  30M2% | 467C  2318C | 3004%  472C
Tee0z 20120210 105142 2283C  3080% | 472C  2307C | 3004%  4TIC
6603 20120210 105212 2282C  3076%  489C  231aC | 3043%  47IC
6604 20120210 105242 2282C  3087%  475C  2308C | 3028%  478C
16605 20120210 105312 2282C  3083%  472C  236C  3043%  472C
16606 20120210 105342 2283C  3083%  473C  2308C | 3023%  476C
16607 20120210 105412 2286C  4127%  901C nan nan nan v

Figure 11: Downloading with an External Sensor

= CVSfiles and Excel files will contain both sets of data.

= PDF reports are of the external data.

= The PC application graph can show internal data by clicking on the "Internal" checkbox and then “Read”. To

show the external data click on the "External" checkbox and then “Read”.
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4.10. Text Size

It is possible to change the application text size by

selecting from the Text pulldown on the program header.

The Auto setting selects one of the sizes based on
screen resolution. When the application reopens, text
size is remembered.

4.11. Language

The GUI application comes with language translation.
Today one can select between English, German and
Danish from the Language pulldown on the program
header. Future versions will support more languages.
When the application re-opens, language preference is
kept.

5. BATTERY REPLACEMENT

The Minnow 2.0 logger runs from two standard coin cell
batteries. We recommend a CR2032 240mAH coin cell
battery. There are different manufacturers but a good
one is Panasonic CR-2032. You can find it easily on the
web from different places such as www.digikey.com,
www2.mouser.com and probably in your local
supermarket. The key thing is to choose a CR2450
battery with high capacity since this will translate into a
longer logger battery life.

6. SUPPORT

For technical support regarding your Senonics logger
please contact:

support@senonics.com
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5 Senonics PC Application (1.2.3)
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Logger Minnow 2.0TH (Temper Auto
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Figure 12: Altering Text Size

m Senonics PC Application (1.2.3)

File View Export Options Language Text Help
— Danish

__ac: ﬂ German

®  English

Logger Minnow 2.0TH [ Temperature & Humidity)
- . = T . . 1 Icl

Show internal sensor or
r external sensor data

Figure 13: Language Preference

First remove the Minnow cover by unscrewing the four
fastener screws (#1 Philips) at the rear of the logger.

Insert two new batteries as shown being careful not to
touch any exposed electronics in the process. Be careful
also to connect the batteries in the correct orientation.

Finally re-attach the cover and tighten the fastener
screws again (be careful not to over tighten).
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